VALSEDLAR

Valsedlar (e. menu) pjéna pvi hlutverki ad veita adgang ad einstaka vefsidum i Joomlavef. Hver
vefur getur innihaldid einn eda fleiri valsedla sem haegt er ad stadsetja hvar sem er a viokomandi
snidmati, p.e. eins og snidmatid leyfir. Hver valsedill getur innihaldid o6tilgreindan fjolda kraekja.
Valsedlum er styrt i Menu Manager (Menus > Menu Manager) sem einnig veitir adgang
umsysluhluta hvers valsedils fyrir sig.

Hér ma sjad hvernig meginvalsedlar eru stadsettir 4 , Left” svaedinu i rhuk_milkyway snidmatinu
sem fylgir Joomla uppsetningunni.
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Valsedlar eru stadsettir eins og adrar einingar i Module Manager (Extensions > Module manager).
Par er einnig haegt ad stjérna 6drum pattum sem varda birtingu peirra.

Menus valsedillinn veitir adgang ad ollum valsedlum vefsins. bar er einnig haegt ad velja Menu
Manager sem opnar stjérnsysluhluta valsedla i Moodle. Menu Manager er einnig adgengilegur af
stjornbordinu (Control panel). | Menu Manager er birt yfirlit yfir alla valsedla viskomandi vefs. bar
er haegt ad eyda eda baeta vid valsedlum og sysla med einstaka valsedil med pvi ad haka vid hann
og smella sidan a [Edit] hnappinn. Eda einfaldlega med pvi ad smella 4 vidkomandi takn i Menu
Item(s) dalknum.
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Joomial is Free Software released under the GHU/GPL License.
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Pegar syslad er med einstaka valsedil opnar Menu Item Manager glugginn par sem birt er yfirlit
yfir einstaka paetti valsedilsins, p.e. kraekjur. bar er haegt ad fjarleegja eda baeta vid kraekjum &
valsedil dsamt pvi ad breyta r6d peirra sem fyrir eru.
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Joomla! is Free Software released under the GNU/GPL License.
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SPURT OG SVARAD

HVERNIG BY EG TIL NYJAN VALSEDIL?

Valsedlar eru bunir til i Menu Manager (Menus > Menu Manager). bar er smell &4 [New] hnappinn
til pess ad stofna nyjan valsedil. [ glugganum sem opnast eru fylltar Gt upplysingar um hinn nyja
valsedil.

S.Fjalar 2008 -13- www.sfjalar.net



Y Joomlal’ Joomla 1.5

Site = Menus  Content = Components Extensions @ Tools | Help [ Preview 0 1 @ Logout

[l Menu: [new; e 0 O

Save  Cancel  Help

Unique Hame:
Title:

Description:

@eeoe

Module Title:

Joomia' is Free Software released under the GNU/GPL License.
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Fylla verdur ut eftirfarandi reiti pegar valsedill er stofnadur:

e Unique Name
Hér er skrdd einkvaamt nafn a valsedilinn. betta er nafnh sem Joomla notar en er ekki birt a
vefnum eda notendavidmotinu. Hér ma ekki nota sérislenska bokstafi eda ordabil.

o Title
Titill valsedilsins. Birtist i listanum yfir valsedla i Menu Manager og einnig 4 sjalfum
vefnum, ef valid er ad birta titil.

e Description
Lysing a valsedlinum. Lysingin parf ekki ad vera mjég nakveem og er einungis hugsud fyrir
vefstjora. Birtist ekki a vefnum sjalfum.

e Module Title
Titill & einingu. Birtist einungis i Module Manager.

HVERNIG STADSET EG VALSEDLA A VEFNUM?

Valsedlar eru einingar (Modules) og pvi syslad med pa sem slika. Umsysla eininga fer fram i
Module Manager (Extensions > Module Manager). A medfylgjandi mynd ma sja valsedil sem
nefnist Titill og er stadsettur a Left sveedi snidmatsins (sja Position dalkinn).
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Til pess ad breyta stadsetningu valsedilsins (eda eininga almennt) er einfaldlega smellt 4 heiti hans
i listanum og opnast pa umsysluhluti einingarinnar.
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#% Module: [Edit] e v OO

Save  Apply Close  Help

Details Parameters
Module Type: mod_mainmenu » Module Parameters
Title: [Titil Menu Name | meginvalsedill [=]
Show Title: @) ng @ Yes Menu Style | List [=]
Enabled: @
Position: tartledetiio
End Level 0

Order:

Always show sub-menu

Access Level:
tems @ No © ves

Target Position
1D:

Description: ¥ Advanced Parameters

b Other Parameters

Menu Assignment
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Stadsetning valsedilsins er skilgreind i Position valsedlinum.

HVERNIG BY EG KRZEKJUR A VALSEDLI SEM ViSAR A STAKA SiBU A VEFNUM?

Algengast er ad kraekjur a valsedli visi @ adrar sidur a viokomandi vef. Pegar ny kraekja er sett a
valsedil er fyrst opnadur vidkomandi valsedill og smellt 4 [New] hnappinn i hnappastikunni efst til
haegri.
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t‘_‘l Menu Item Manager: [mainmenu] = 4 o e led -I rd l_l
New

Menus Defautt  Publish  Unpublish Move Copy Trash Edit Help

Fiter =3 Nax Levels 10 [ ] - Select State - [« ]

# [ Menu ltem Default  Published  Ordera ¥ Access Level Type ttemiD
1 [[] Home W o 1K Public: Articles » Front Page 1
2 [F] Joomia! Overview ' . v 2 Public Articles 2 Article 27
3 [} |_what's New in 157 i , 1 Public Articles » Article 34
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Opnast pa skjamynd par sem valid er ur 6likum tegundum sidna og smellt & Articles undir Internal

Link (e. innri kraekja) valkostinum.

e .

¥ Joomlal™ Joomla e

Site = Menus  Content = Components Extensions @ Tools | Help [ Preview 0 1 9 Logout

B Menu item: [new; Q O
Cancel  Help

Select Menu item Type

2~ [ Internal Link
o Articles
- Archive
o Archived Article List
o Article
C o Article Layout )

o Article Submission Layout

= Category
o Category Blog Layout
o Category List Layout
= Front Page
o Front Page Blog Layout
@ Section
o Section Blog Layout

o Section Layout
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Article Layout snidid birtir staka vefsidu og er notad til pess ad visa @ milli stakra sidna & vef.
Tilgreinar parf titil og velja pa sidu sem kraekjan skal visa til. Adrir valkostir eru valkvaemir. Nytt
atridi 4 valsedli baetist sjalfgefid nedst 4 vibkomandi valsedil. Haegt er ad breyta stadsetningunni

.
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B Menu item: [new; e v Q O
Save Apply  Cancel Help
Menu item Type = Parameters (Basic)
. Change Type i Sele Asticle )
Article Layout ( Select Article ot an Adti Seloct

The Article Layout displays a single Article: » Parameters (Component)
» Parameters (System)

Menu Item Details
C Title: )

Alias:

Link: [index.php?epticn=com_contentéview=srticie
Display in: |MainMenu  [w]

Parentitem: | EER -

Home
Joomlal Overview

- What's New in 1.57
Joomla! License

Meore about Joomla!
FAQ

The News

Web Links

News Feeds a

Published: @ yp @ vyes
Order: New Menu tems default to the last position. Ordering can be changed after this Menu ftem is saved.
Access Level: |EIEIEHIN -

Registered
Spedial

On Click, Open in:
New Window with Browser Navigation
New Window without Browser Navigation
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HVERNIG BREYTI EG ROP KRAKIJA A VALSEDLI?
Til pess ad breyta rod kraekja a valsedli er viokomandi valsedill fyrst valinn. Pad er einfaldast ad
gera med pvi ad velja nafn valsedilsins af Menus valsedlinum. Birtist pa tafla yfir allar kraekjurnar

sem valsedillinn hefur ad geyma.
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Fiter: [ee] Max Levels 10 [+ ] - Select State - [=]
# A Menu Item Default Publishey” Ordera A N\ Access Level Type ItemiD
1 [E] Home o q Public Articles » Front Page 1
2 [F]  Joomia! Overview - 2 Public Articles » Article 27
[ . -whatsNew in15? o 1 Public Articles » Article
[7]  Joomia! License o 3 Public Articles » Article 2
D More about Joomla! 4 4 Public Articles » Section
[ Faa =4 5 Public Articles » Section 4
[E] The News vl & Public Articles » Category / Blog 50
8 [F]  web Links v 7 Public Web Links » Categories 43
[[] News Feeds o kil Public News Feeds » Categories
10 [F] Senda inn grein v 9 Public Articles » Article / Form

Display # 20 [+

Joomla! is Free Software released under the GNU/GPL License.

Til pess ad breyta rod kraekja a valsedlinum er annad hvort smellt 8 6rvahnappana fyrir aftan
viokomandi sidu (upp eda nidur), eda ny rod sleginn inn i reitina & Order dalknum. begar ny réd er
slegin inn i Order dalkinn verdur ad smella & disktdknid efst i ddlknum til ad vista breytingarnar.

HVERNIG BY EG TIL UNDIRSIDUR?

Undirsida er sida sem er undirskipud annarri 4 valsedli. Undirsidur er haegt ad mynda annad hvort
um leid og kreekja er buin til 4 valsedil eda hvenaer sem er eftir a. Til pess ad skipa sidu undir adra
er valsedillinn sem inniheldur kraekjuna fyrst opnadur og sidan er vidkomandi kraekja valin ur
toflunni yfir kraekjurnar. Opnast pa sami gluggi og notadur er til ad bua til ad breyta kraekju a
valsedli.

Y Joomlal’ Joomla

Article Layout

The Article Layout displays a single Article.

Menu Item Details

i, g ipanh s i it

0: 34
Title: [What's New in 1.57
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Link: [index.php?op ¥
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Save  Apply  Close  Help
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Select Article. [WhatsHewin 157 | | Salect

» Parameters (Component)

» Parameters (System)
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Til pess ad gera eina sidu ad undirsidu annarar a valsedlinum er yfirsidan (e. parent item) valin af
listanum yfir sidurnar a valsedlinum. A3 pvi loknu er smell & Save hnappinn & taekjastikunni efst i
vinstra horni.

[ toflunni sem geymir yfirlit yfir sidur & valsedli eru undirsidur birtar inndregnar undir yfirsidunni.

A Joomlal” Joomla —
site Menus Content  Components Extensions  Tools Help (28 Preview 0 ®1 9 Logout
— - - —
[‘_‘l Menu Item Manager: mainmenu] E W Lo e 3 ] @ O

Menus Defaut Publish Unpublish  Move  Copy  Trash Edit New Help
Fiter =3 Hax Levels 10 [] - Select State - [+ |
# | Menu ltem Default  Published Ordera ¥ Access Level Type ItemID
1 [ Home e w r 1 Public Articles » Front Page 1
2 [F] Jeomia! Overview o . v 2 Public Articles » Article 27
3 = L what's New in 1.57 o 1 Public Articles » Article 34
4 D Joomia! License - . ¥ 3 Public Articles » Article 2
D More about Joomla! o . v 4 Public Articles » Section
[ Faa o . »| 5 Public Articles » Section 41
[F] The News o . | @ Public Articles » Category / Blog 50
8 [F] Vieb Links. o - 7 Public Web Links » Categories 48
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HVERNIG BY EG TIL KREKJU A YFIRLITSSIDU YFIR EFNI FLOKKS (E. CATEGORY)?
Haegt er ad birta yfirlit yfir efni flokks (e. category) 4 tvennan hatt, p.e. annad hvort sem lista eda
med yfirlitssidu, sem svipar mjog til greinaskipan a forsidu vefs.

Hér getur ad lita allar greinar/sidur sem skradar eru i ,Latest” flokkinn (e. category) i hefdbundinni
Joomla uppsetningu, p.e. par sem synisgognin eru notud. Eins og sja ma er um 5 greinar/sidur ad
reda. ,Llatest” flokkurinn er undirflokkur ,News” og inniheldur fréttir eins og nafnid gefur
sterklega til kynna.
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Site  Menus  Content  Components  Extensions  Tools  Help (¥4 Preview 0 M1 O Logout
= - 2 -
| Article Manager £ R M ez ) - ©@ R ©Q
Unarchive  Archive Publish  Unpublish Move Copy Trash Edit New Parameters Help
Fitter: [ee ] - Select Sedion - | Latest [=] - Select Author - [+] - Select State - [=]
# @O Title Published Front Page Orders ¥ Access Level Sectiona Category Author Date  Hits ID
1 [ it = ' v 1 Public News Latest Administrator 061208 2
2 D Welcome to Joomia! :J ' . 2 Public News Latest Administrator 12.1006 92 1
[E] Joomia Community Portal Online = ' . v 3 Public News Latest Administrator 070704 0O
4 D The Mew Joomla Security Strike Team ~ ' . 4 Public News Latest Administrator 07.0704 0
[F]  We are Volunteers :a w . 5 Public News Latest Administrator 070704 54 6
D Stick to the Code! ~ ' . 8 Public News Latest Administrator 07.0704 55 7
[[] The Legend of Buca di Beppo — o . w| 7 Public News Latest Administrator 120404 13 8
& [ 1 Milion Smiles = ' . & Public News Latest Administrater 07.07.04 23 9
Display # 20 [+

__ Published, but is Pending | :1 Published and is Current | _Q Published, but has Expired| ) MNotPublished| ¢y Archived

Click on icon to toggle state.

Til pess ad birta sérstaka sidu a vefnum sem veitir yfirlit yfir innihald pessa flokks er fyrst valinn
viokomandi valsedill. Hér verdur notast vid Main menu og innihald hans pvi valié af Menus
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valsedlinum a stjornbordi Joomla. Smellt er & [New] hnappinn @ hnappastikunni fyrir ofan téfluna
med kraekjum valsedilsins.

Smellt er & Articles par sem aetlunin er ad birta yfirlit yfir greinar eda sidur og pvi naest Category
Blog Layout til ad birta yfirlitid a ,blogg-snidi“ sem pydir i raun ad hverri grein fylgir stuttur
inngangur.

Y Joomlal Joomla Verson 157

site | Menus  Content = Components  Extensions @ Tools | Help [ Preview 0 M1 O Logout

[l menu item: [new: Q O

Cancel  Help

Select Menu ltem Type

& [@ Internal Link
- Articles
@ Archive
o Archived Article List
o Article
o Articl Layout
o Article Submission Layout
- Categery
C o Category Blog Layout )

o Category List Layout

& Front Page
o Front Page Blog Layout
- Section
o Section Blog Layout
o Section Layout
o- Contacts

o- News Feeds

o Pols
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Ad pessu loknu er kraekjunni & valsedlinum gefid nafn og vidkomandi flokkur valinn i Category
svaedinu undir Parameters (Basic) lidnum.
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B Menu Item: [new; e v Q

save  Apply Cancel  Help

Menu Item Type - Parameters (Basic
Category - Select Category - [=] )

Category Blog Layout

Description @ Hige ) Show
This layout displays an Article Category in Blog format.
Description Image @ Hige ©) Show

Menu Item Details

( i ) # Leading

1
Alias: #Intro |2
Link: [indexphp?op X i g Columns |2

Display in: |Main Menu  [] #Links |4
parentitem: I - » Parameters (Advanced)
Home T
Joomla! Cverview » Parameters (Component)

- What's New in 1.57
Joomla! License
More atout Joomla!

» Parameters (System)

m

FaQ

The News
Web Links
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Einnig ma stilla birtingarmata greinanna a svipadan hatt og greinar a forsidu vefs, pb.e. med pvi ad
fylla ut fjogur svaedi sem dkvarda fjolda og skipan greina a sidunni. Svaedin eru eftirfarandi:

o {#leading
Upphafsgrein eda greinar.
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e #intro
Inngangur ad fleiri greinum.

e #Columns
Fjoldi dalka fyrir inngangsgreinarnar. Hér er yfirleitt notast vid einn eda tvo dalka par sem
snidmat rada yfirleitt ekki vid fleiri dalka.

e #Links

Fjoldi greina sem kraekt er i nedst & sidunni. Hér eru einungis birtir titlar greinanna.

A myndinni hér fyrir nedan ma sja hvernig yfirlitid birtist ekki 6svipad og forsida a vef. A myndinni
eru einnig skyringar med ofangreindum sveedum.

E’Q Joomlal

...because open source matters

Joomlal makes it easy to launch a Web site of any kind. Whether you want a brochure site or you are building a large
online community, Joomla! allows you to deploy a new site in minutes and add extra functionality as you need it. The
hundreds of available Extensions will help to expand your site and allow you to deliver new senvices that extend your
reach into the Internet.

About Joomla! Features Hews The Community
Home == Flokkur - listi search...
Latest
Welcome to Joomla! & = &2
Joomla! is a free open source framework and content publishing system d d for quickly creating highly interactive multi-

Upphafsgrein language Web sites, online communities, media portals, blogs and eCommerce applications.

eda greinar

Powered by Joomla! provides an easy-to-use graphical user interface that simplifies the management and
. . publishing of large volumes of content including HTKML, documents, and rich media. Joomla! is used
& JOOI T IC]' by organisations of all sizes for Public Web sites, Intranets, and Extranets and is supported by a

version 1.5 community of thousands of users.

Read more... ==

Stick to the Code! & = &2

We are Volunteers & = =2

To ensure this code release, Wilco Jansen resorted to sending
rum to joint lead-developer Johan Janssens. Johan, who's had a
penchantfor rum ever since the first "Pirate’s of the Caribbean”
maovie screened, took the bait, mixed it with Cola, and here we are

Inngangsgrein
eda greinar, Hér
er haegt ad velja

délkafjdlda. with our latest 1.5 release. It looks like pirate talk will figure quite a
lotin future Joomla! development!
Read more... ==
More Articles...
Kraekjur i 1 Million Smiles

L
* The Mew Joomla Security Strike Team
+ Joomla Community Portal Online

# The Legend of Buca di Beppo

fleiri greinar

The Joomla Core Team consists of volunteer developers,
designers, administrators and managers who, together with a
large range of Work Groups of dedicated community members
have taken Joomla to new heights in its relatively shor life. This
well-oiled machine is often copied but never surpassed.
Joomla has some wonderfully talented people taking Open
Source concepts to the forefront of industry standards. Joomla
1.5is a major leap forward and represents the most exciting
Joomla release in the history ofthe project.

Read more... =»

« Start Prev1 2 3 Next End =

Page 1 of 3

Til pess ad birta yfirlit yfir greinar i akvednum flokki (e. category) sem einfaldan lista er fyrst buin til
kraekjan a viokomandi valsedil likt og i fyrra tilfellinu, en i stad pess ad velja ,, Category Blog Layout”
er valid Category List Layout.
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Y Joomla!l” Joomla

0 M1 O Logout
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Cancel  Help

site Menus Content = Components Extensions | Tools Help (28 Preview

El Menu Item: [New]

Select Menu item Type:

2 [@ internal Link
o Aticles
o Archive
o Archived Article List
5 Aricle
o Aricle Layout
o Article Submission Layout
- Category
o Category Blog Layout
C o Category List Layout )

o Front Page

o Front Page Blog Layout
@ Section
o Section Blog Layout
o Section Layout
o Contacts
o-News Feeds

- Polls.
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Valkostirnir sem fylgja pessu snidi eru ekki alveg eins fjolbreyttir en atid verdur ad skrd nafn &
kraekjuna i valsedlinum og velja viokomandi flokk til birtingar. Helstu stillingar par ad auki hafa
med fjolda atrida a sidunni ad gera og er hann skilgreindur i #Links svaedinu (sjalfgefin stilling er
10).

Y Joomlal’ Joomla

This layout displays Articles in a Category.

Access Level:

»
Registerad

Version 157

Site = Menus  Content = Components  Extensions @ Tools | Help [ Preview 0 M1 Q Logout
B Menu item: (i) e v QO O
Save  Apply  Close  Help
HMenu item Type » Parameters (Basic)
o >
Category List Layout St/ = =]
#Links (10 [=]

Table Headings  © Hde @ Show
Menu Item Details Date Column | Hide [w]
D: 54 Date Format
C itie: [Fiour- i )
Alias: [flosur-listi Filter © Hide @ Show
Link: |index.php?op . 0 Filter Field | Tite [w]
Display in: |Main Menu [ » Parameters (Advanced)
Parent Item: -
" = » Parameters (Component)
ome
Joomla!l Gvernview » Parameters {System)
- Whats New in 157
Joomlal License |
WMere sbout Joomla!
FAQ
The News L4
Web Links
News Feeds <
Published: ) 4, @ ves
Order: |10 (Fiokur - listi) =]
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Mun fleiri stillingarkostir eru mogulegir, s.s. hvada dalkar eru birtir, hvernig dagsetning er sett fram

og hvort listinn er leitanlegur (e. filter).

A naestu mynd mé sja hvernig hefdbundinn listi birtist med sjalfgefnum stillingum.
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7 = ™ The one thing about a Web site, it always changes! Joomlal makes it easy to add Aricles, content, images, videos,
I and more. Site administrators can edit and manage content ‘in-context’ by clicking the "Edit link. Webmasters can also
OOI I I O H edit content through a graphical Control Panel that gives you complete control over your site.
...becaouse open source matters
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# Article Title Author Hits
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2 Stickto the Codel! Administrator 56
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ymsa valkosti.
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